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Summary

This paper covers measures of field colony strength, by which we mean population measures of adult bees and brood. There are generally
two contexts in which an investigator wishes to measure colony strength: 1. at the beginning of a study as part of manipulations to produce
uniform colonies and reduce experimental error and; 2. as response variables during or at the end of an experiment. Moreover, there are two
general modes for measuring colony strength: 1. an objective mode which uses empirical measures and; 2. a subjective mode that relies on
visual estimates by one or more observers. There is a third emerging mode for measuring colony strength; 3. computer-assisted digital image
analysis. A final section deals with parameters that do not directly measure colony strength yet give important indicators of colony state:

flight activity at the hive entrance; comb construction; and two proxy measures of colony fitness: production of queen cells and drone brood.

Métodos estandar para estimar parametros sobre la fortaleza

de las colonias de Apis mellifera

Resumen

Este trabajo trata sobre mediciones de campo de la fortaleza de colonias de abejas, es decir, mediciones de la poblacion de abejas adultas y
de cria. En general hay dos contextos en los que un investigador desearia medir la fortaleza de una colonia: 1. al comienzo de un estudio
como parte de las manipulaciones para producir colonias uniformes y reducir el error experimental y; 2. como variables de respuesta durante
o al final de un experimento. Ademas, en general hay dos maneras de medir la fortaleza de las colonias: 1. una manera objetiva usando
mediciones empiricas y; 2. una manera subjetiva que se basa en estimaciones visuales de uno o mas observadores. Hay una tercer forma mas
reciente de medir la fortaleza de una colonia; 3. analisis computacional de imagenes digitales. La seccion final trata sobre parametros que no
miden directamente la fortaleza de la colonia pero que son importantes indicadores del estado de ésta: actividad de vuelo en la piquera de la

colmena, construccion de panales y dos mediciones equivalentes de aptitud de la colonia: produccion de celdas reales y de cria de zanganos.
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1. Introduction

Herein, we cover measures of honey bee field colony strength, by
which we primarily mean population measures of adult bees and
brood. We will also talk about secondary measures such as: quantity
of stored honey and pollen; “brood pattern” by which is meant the
degree of worker brood solidity or contiguity; and the expression of
visible disease or parasite symptoms. Strictly speaking these secondary
measures are not so much indicators of a colony’s immediate state as
they are legacy effects or predictors of future condition.

For our purposes there are two contexts in which an investigator
wishes to measure colony strength: 1. at the beginning of a study as
part of manipulations to produce uniform colonies and reduce
experimental error and; 2. as response variables during or at the end
of an experiment. Moreover, there are two general modes of measuring
colony strength: 1. an objective mode which uses empirical measures
such as weight (mg, g, or kg) or area (cm?), covered in sections 3 and
4.1. and; 2. a subjective mode that relies on visual estimates by one
or more observers, covered in sections 4.2. and 5.1. The objective
mode is the more accurate of the two, but it is also invasive and
disruptive to the bees, constituting in some cases the complete
deconstruction and reassembly of colonies with disruption to any
social cohesion formerly intact. For this reason we consider the objective
mode best suited to the beginning and end of experiments. In
contrast, the subjective mode is less accurate, but far less disruptive to
the bees and therefore appropriate for collecting response variables
during the experiment when the investigator has an interest in
preserving the social cohesion and health of experimental colonies.
One exception to this would be if the sampling intervals are sufficiently
distanced (2-3 times per year) to justify the objective mode throughout.
Nevertheless, with safeguards in place such as we describe below, the
subjective mode is an acceptably robust technique.

There is a third emerging mode for measuring colony strength; 3.
computer-assisted digital image analysis, covered in sections 5.2. — 5.5.
This method is minimally invasive, automatically generates archival
images for data traceability and verification, provides objective empirical
data, and can be done moderately quickly. Its chief disadvantages are
cost and dependence on technology. Moreover, it is the opinion of
some that the speed and ease of visual estimates surpass the
advantages of objectivity and archival properties of digital methods.
Nevertheless, we will probably see technical improvements and
increasing use of this mode in the near future. Computer-assisted

digital image analysis is useful for experiments that call for measures

of bee health or development but fall short of field-scale colony
strength assessment, chief examples being laboratory studies in
environmental toxicology or nutrition.

The sections 5.6. — 5.9. cover methods that do not fit neatly into
the other sections. These include: measuring flight activity at the
entrance; comb construction; and two proxy measures of colony
fitness: production of queen cells; and drone brood.

A note is warranted here on a couple omissions from this chapter;
gross colony weight and X-ray tomography. Gross colony weight is a
useful metric in the context of seasonal changes in forage availability.
Hive-scale data have long interested beekeepers for their usefulness
in tracking local nectar flows, and more recently these kinds of data
have been used to monitor flowering phenology in the context of
climate change (Nightingale et al., 2008). As a measure of colony
strength per se, however, gross colony weight is ambiguous and
unreliable, owing to the fact that workers from health-compromised
colonies may express precocious foraging with the result that weights
of colonies may increase, not decrease, in response to disease or
other disorders (Mayack and Naug, 2009). X-ray tomography offers
what is probably the most empirically quantifiable, thorough, and
non-invasive means of monitoring colony strength of colonies of
honey bees or other social insects (Greco, 2010). Although it sets a
gold standard, its formidable technical requirements keep this method

out of reach of most honey bee researchers.

2. An optimal colony configuration

In establishing colonies for experiments, it is useful to have some
guidance on how colony population size can be expected to affect
colony growth, behaviour, and survivorship. The best guidance in this
matter comes from John Harbo (1986) who compared brood production,
worker survival, and honey gain in colonies begun with no brood and
2,300, 4,500, 9,000, 17,000, or 35,000 bees while fixing bee density
at ca. 230 per 1000 cm? hive space. The experiment was repeated in
each of the months of Feb, Apr, Jun, Aug, and Oct and terminated
before brood emerged. Worker survival (22 days) was significantly
higher in colonies with 2,300-9,000 bees than in colonies with 35,000
bees. Larger populations tended to store more nectar per bee during
times of nectar flow and consume less during times of nectar dearth.
However, smaller populations produced more brood per bee. Harbo
concluded that colonies established with 9,000 bees are a good

optimum between the honey hoarding efficiency of large populations
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Table 1. Pros and cons of two variations of an objective mode for starting up colonies of uniform initial strength.

Method Pros Cons
Classical 1. Results in colonies with initial populations of adult 1. Disease and parasite legacy effect in brood, although
3.1. bees normalized for genetics and pathogen load. normalized, is nevertheless sustained into the experimental period.
2. Results in colonies with brood of all stages, 2. Because brood of all stages is present, progeny turn-over from
accelerating colony growth. new experimental queens is correspondingly delayed.
3. Results in maximized colony uniformity in regards to
initial adult bee populations.
Shook 1. Does not require use of a customized cage to house | 1. Because adult bees are not normalized, between-colony variation
swarm common pool of bees. in genetics and pathogen load remains at pre-experiment levels.
3.2.

2. Sustains colony-specific identity from
pre-experimental to experimental period

2. Because colonies begin broodless, colony growth is delayed.

3. Because of #2, drift is not a concern and it is not
necessary to move experimental colonies from the
source apiary.

4, Because all brood is removed and replaced with
frames of foundation, disease and parasite legacy effect
is minimized.

5. Because of #4, if varroa control is an element of
experimental design, the initial broodless period
provides an ideal opportunity to treat for mites.

and the brood rearing efficiency of small colonies. Colonies that are
significantly larger than this are costly and labour-intensive to set up
and less suitable for measures of population growth because they are
already near their maximum. Colonies significantly smaller than this
may do well at the height of the season, but they are more vulnerable
to winter and summer stresses. Bees are normalized for colony-source
genetics and parasite loads if colonies are set up with the common
pool of bees as described in section 3.1. If colony growth is a measure
of interest, the investigator can invite a greater range of expansion if
colonies are begun with no brood. But if one prefers to provide colonies
with brood, it is reasonable to stock colonies of 9,000 bees with no
more than two combs of brood of various ages, allowing plenty of

open cells to accommodate growth.

3. Setting up experimental colonies
of uniform strength

This section describes two variations of an objective mode for setting
up uniform colonies for experiments. The first (3.1.), which we call
the classical objective mode and a variation (3.2.), the so-called

“shook swarm” method. Table 1 explains the pros and cons.

3.1. Classical objective mode

One of the recurring pitfalls of honey bee field research is large
experimental error which handicaps the investigator’s attempts to
discriminate statistical differences among effects of interest. One of
the best ways to minimize this problem is to begin experiments with

colonies as uniform as possible in regard to comb space, food

resources, and populations of adult bees and brood. It is the job of
the investigator to distribute these resources equitably among
experimental colonies.

The following synthesis draws from methods pioneered by John
Harbo who was interested chiefly in reducing environmental variation
in honey bee breeding programs (Harbo, 1983, 1986, 1988, 1993;
Delaplane and Harbo, 1987) and adapted later by workers who
recognized the utility of these methods for field research on Varroa
destructor (Delaplane and Hood, 1997, 1999; Ellis et al, 2001;
Strange and Sheppard, 2001; Berry et a/, 2010) and colony growth
(Berry and Delaplane, 2001).

1. The goal is field colonies equalized with regard to bees,
brood, mites, and food resources within units of higher-order
experimental replication, i.e. blocks or whole plots, usually
based on geography.

2. Empty hives are pre-stocked with brood, empty combs, syrup
feeders, and a caged queen in advance of receiving worker
bees (Fig. 1). Bottom boards and hive bodies are stapled
together to prepare them for moving. Hive entrances are
screened to temporarily trap bees; this is done for two
reasons: 1. experimental colonies often need to be moved to a
permanent site and away from the source colonies from which
workers are collected and; 2. a period of in-hive confinement,
usually overnight, seems to help bees orient to their new hive
and queen.

3. Brood for incipient experimental colonies can be collected
from the same source colonies used to collect adults. A near-
equal quantity of brood is then assigned to experimental

colonies without regard to source. We do not prescribe
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instrumentally inseminate sister queens (see the BEEBOOK
paper on instrumental insemination of queens (Cobey et al.,
2013)) with the same pool of mixed drone semen.

6. Adult bees are collected for experimental set-up by shaking
workers from a diversity of source colonies into one large,
common, ventilated cage, allowing workers (and diseases and
parasites) to freely mix. With African subspecies, it helps

minimize loss from flight to first spray bees on the comb with

water mist. The cage is maintained in cool conditions to

Fig. 1. Investigators pre-stocking experimental hives with equal

prevent bee death from over-heating for at least 24 hours to

numbers of brood combs and honey combs and caged queens in allow thorough admixing of bees, resulting in a uniformly

ion fi ivin k from mmon .
preparation for receiving worker bees from a common cage heterogeneous mixture. The weight of bees collected (kg)

should exceed the target weight of bees needed for the study

“random” brood assignment because the investigator should by at least 2 kg, or at least by a third in the case of African
place a higher priority on equalizing quantity of brood over subspecies, to account for bee loss through death or flight.
concerns of non-random assignment of brood. Efforts should be Bee survival in the cage is greatly improved if the investigator
made to equalize the relative quantity of sealed versus open designs it to accommodate 5-6 Langstroth sized brood combs
brood. A measure of beginning quantity of brood is done by to provide clustering surface (Fig. 3).

overlaying on each side of every brood comb a grid pre-
marked in cm? and visually summing the area of brood (Fig. 2)
The area (cm?) of brood can be converted to cells of brood
by multiplying cm? by the average cells per cm?. This value
varies by geography and bee genetics (Table 2), or the
investigator can determine local average cell density per cm?
by counting the number of cells directly in a square equalling
one cm?and using the mean of at least ten measurements.
4. In a similar fashion the investigator can derive and equalize
the beginning number of cells of honey or pollen or even cells
that are empty. Depending on one’s standards for strict
uniformity, it may be simpler to provide nothing but brood or
empty cells and to provide uniform nutrition across the
experiment by use of sugar syrup and protein supplements.
5. Variation due to bee genetics is minimized by providing each

colony a sister queen reared from the same mother and

open-mated in the same vicinity. A more robust option is to

/o P = 7*5 & /;7 e =

Fig. 3. A ventilated cage made to hold a large common

heterogeneous mixture of bees for starting experiments.

7. In order to equalize initial colony populations, it is preferable
to make colony-specific caged cohorts. Empty screened cages,
ideally made to fit on top of an empty hive, are each pre-
weighed or tared with a balance in the field. The large
common cage is opened, the bees sprayed with water to
reduce flight, then bees transferred from the common cage
into the smaller colony-specific cages with the aid of cups or

scoops (Fig. 4). Bees are added or removed from each colony-

A o %
Fig. 2. A transparent plastic grid etched in square centimetres is used cage until the target weight is achieved and recorded,

to visually sum the surface area of brood. preferably > 2 kg.
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Table 2. Surface area of some regionally common frame types and expected bee density when frame is fully occupied by worker bees.

- 2 N
Region Local frame type Number be:es per fully- | Surface (cm*®) per side Bees / cm? | Ref Worker cz:ells /
occupied side of frame cm
North America Deep Langstroth 1215 880 1.38 2 3.75-3.9¢
North America 3/4s 910 655 1.39 a
North America Western 785 565 1.39 2
North America Shallow 640 461 1.39 2
Europe Swiss 1200 930 1.29 b 4,0
Europe Dadant 1400 1130 1.24 b 4.0¢
Europe German normal 900 720 1.25 b 4.0¢
Europe Langstroth 1100 880 1.25 b 4.0¢
Europe Zander 1000 810 1.23 b 4.0°
Jumbo for brood
South and Central America chamber (modified 1980 1130 1.75 f 4.1-4.79
Dadant)

: Jumbo for super f 479

South and Central America (modified Dadant) 920 520 1.77 4.1-4.7
We are not aware of published methods for determining bee numbers and cell density with A. mellifera in Africa.
Africa However, these bees are ca. 3% smaller than African bees in South America”, so it is reasonable to apply this
conversion to the values given above for South and Central America.

Burgett and Burikam (1985), ®Imdorf and Gerig (2001), “Harbo (1993), Harbo (1988), cImdorf et a/. (1987), ‘Gris (2002), Guzman-Novoa et a/. (2011),
PBuco et al. (1987).

8.

Fig. 4. Bees are transferred from the common cage to hive-specific

A sample of ca. 300 workers is collected from each incipient
colony into a pre-weighed or -tared screw-top container,
weighed fresh, then the number of bees counted in the lab to
derive a colony-specific measure of average fresh weight of
individuals (mg per bee). To count bees it is necessary to first
immobilize them, either by freezing them or non-sacrificially
with CO, narcosis. Dividing initial colony cohort size (kg, from
step 7) by average fresh weight of individuals (mg) gives
initial bee population for the colony.

A variation of steps 7 and 8 is available if the investigator is
using nucleus hives small enough to weigh entire in the field
(Fig. 5). In these cases, the intermediate step of a colony-
specific cage is not necessary and the investigator can scoop

bees from the common cage directly into the pre-weighed or

cohort cages by use of cups or scoops.

tared hive. The net weight (kg) of bees is recorded, then

initial population determined the same way as given in step 8.

10. If initial measures reveal outliers in the amount of bees,

brood, honey, pollen, and empty cells, corrective action
should be taken. In general, corrections aimed at minimizing
experimental error are permissible until the point at which

treatments are begun.

11. After bees and all resources are placed inside hives (with

entrances screened, but without sugar syrup which can spill in
transit), hives are then moved to their permanent apiary site.
Over-heating is a risk, and hives must be kept as cool as
possible. There is a special advantage to setting up colonies
late in the day and moving hives to the experimental apiary at
night. Not only is it cooler, but once hives are unloaded and
entrances opened, the bees do not fly because of the

darkness and this protracted period inside the hive seems to

field, bypassing the need for intermediate hive-specific cohort cages.



help them orientate to the new queen and reduces

drifting. Colonies can be given sugar syrup after they are

unloaded or 24 hours later after bees have settled down.
12. Apiaries should be arranged to limit worker drift between
colonies. This can be done by “complicating” the visual field of
bees with orientating landmarks near their nest entrances.
This can be as simple as using rocks or trees or more
deliberate such as painting varying geometric shapes on hive
fronts. Arranging hives in a strongly linear arrangement is not
good because hives at the ends tend to accumulate bees. For
this reason some investigators place hives in a circle.
13. Colony maintenance should include control of non-target
diseases and disorders, queen conservation, swarm
prevention, and feeding as necessary. Of these, queen loss
and swarming tend to be the most disruptive to colony
populations. Cutting out queen cells, adding honey supers,
marking queens, and regular inspections can reduce these
problems. If honey supers are added, it is best to add them
above a queen excluder to limit the range of the queen’s egg-
laying activity. The goal of these manipulations is to decrease

experimental residual error.

3.2. Shook swarm objective mode

1. With this method it is assumed that investigators will use a pre
-existing apiary and modify it for the experiment’s purposes.
It is important that the experiment start at a time of year that
the bees can draw out foundation into comb.

2. In the days leading up to set-up, queens in each colony are
caged and returned to the colony to save time on set-up day.
Colonies are removed from the apiary if they are expressing
disease symptoms, significantly under-performing, or
otherwise causing excessive between-colony variation. New
colonies are imported if needed to reach the target colony
number and treated similarly.

3. A number of empty hives equal to the target number of
colonies is brought to the apiary, each stocked with brood
chamber frames of new foundation, including honey supers with
frames of foundation if the nectar flow warrants, and sugar
syrup feeders. If affordable, it is good to start new colonies on
factory-new woodenware to avoid confounding issues of any
disease legacy effects.

4. Each hive in the apiary is moved aside and an empty hive set
in its place. Roughly half of the frames of foundation are
momentarily removed to create space, then the caged queen
is suspended between two centre-most frames of foundation.

5. Combs of bees from the original colony are then sequentially
removed and the adult bees shaken off the combs into the
new box. Bees are bounced or brushed out of the supers and
the bee-free combs returned to them and covered to

discourage robbing behaviour.

Delaplane et al.

6. Once all bees are shaken into the new hive, the frames of
foundation initially removed are now returned to the new
boxes, gently to avoid injuring bees which may be heaped on
the floor. Unless there is a strong nectar flow in progress, it is
advisable to feed experimental colonies sugar syrup to
encourage drawing out the new foundation.

7. The old bee-free boxes of combs are then removed from the
experimental apiary and the combs used as needed elsewhere
as supplemental brood or feed.

8. After one day, the caged queens in experimental colonies are
released. Colonies are subsequently monitored for queen
performance and normal colony development. Poor-performing
queens are replaced as needed to minimize within-apiary
experimental error. Once colonies reach a development state
consistent with the experiment’s objectives, treatments may
be applied and the experiment begin.

9. The expected outcome of this manoeuvre is a high degree of

within-apiary consistency in colony developmental state.

4. Measuring colony strength at

end of experiment
4.1. Objective mode

This section is derivative of the references cited in section 3.1.

1. The day before the experiment is ended, each queen is found,
caged with attendants, and returned to her colony. This will
save a great deal of time the next day. Additionally, any hive
cracks or gaps are sealed with duct tape to prevent bee loss.

2. The night or early morning before colonies are dismantled, the
entrance of each colony is securely closed with a ventilated
screen to trap workers inside.

3. Ending colony adult bee population is derived from net colony
bee weight (kg) and average fresh bee weight (mg). Each
screened whole hive is weighed in the field, then opened, all
bees brushed off every comb and surface (usually into a
temporary holding hive), and the hive re-weighed without
bees. The difference in weight is the net weight of bees. A
sample of ca. 300 live bees is collected into a pre-weighed or
-tared container, weighed, the bees frozen or narcotized with
cold or CO,, and counted to determine average fresh weight
(mg) per bee. Net colony bee weight is divided by average
fresh weight per bee to derive colony bee population. If the
fresh bee sample is frozen or stored in alcohol, it can be used
to later determine adult loads of diseases, varroa mites, or
other parasites of the investigator’s choice.

4. Combs are labelled to preserve colony-specific identity and
moved to the laboratory for further measures.

5. Number of brood cells is derived as described in section 3,

using a grid pre-marked in cm?, visually summing the area of
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Fig. 6. A piece of cardboard with a square equal in size to 10 x 10

cells is laid over a patch of brood. Percentage brood solidness is
measured directly as (100 - no. empty cells).

brood (Fig. 2), and converting area of brood (cm?) to cells of
brood by multiplying cm? by the average cell density per cm?
appropriate to one’s locality (Table 2). This same method can
be used to derive cell number of any comb resource of
interest to the investigator; honey, pollen, or empty cells.

6. Brood solidness is determined by placing a grid that delimits 100
cells over a section of sealed brood and subtracting empty cells
to estimate percentage brood solidness (Fig. 6).This measure is
repeated on different patches of brood to derive a mean of at
least ten observations.

7. Alternatively to reporting comb resources as cells, many
investigators report these resources empirically as total are (cm?).

8. In the case of honey, it is traditional to report this variable by
weight (kg). In these cases, the investigator is aided with the
use of queen excluders that restrict brood to the lower hive
bodies. If supers are pre-weighed before adding to hives, the
investigator can determine honey yield by simply weighing
bee-free honey supers at the end of the experiment.

9. Visible brood disorders can be quantified by first selecting a

relatively contiguous patch of brood in the late larval / capped

Fig. 7. A cross-shaped 10 x 10-cm transect intersects in the middle of
a patch of contiguous brood, and every cell along the transect is

opened and assessed for visible disorders.

stage (stage more likely to express visible symptoms), and
overlaying on the patch a 10-cm horizontal transect and a 10
cm vertical transect intersecting at the centre (Fig. 7). Along
each transect every cell of brood is examined under strong
light and magnification for visible disorders, i.e., symptoms
typical of American foulbrood, European foulbrood, sacbrood,
or chalkbrood. The parameter is reported as percentage of

brood expressing visible disorders.

| 4.2. Subjective mode

I This section and the next describe the subjective mode of measuring

colony strength and are thus best suited for collecting response
variables while the field experiment is in progress. The gist of the
method is the use of human observers who visually estimate the
surface area of a comb covered by a target; bees, brood, honey,
pollen, etc., and if necessary convert comb surface to target-
appropriate units, i.e. bees, cm?, or cells. The syntheses in sections 4
and 5 draw from the work of Burgett and Burikam (1985) and
derivative papers from North America (Skinner et al., 2001, Delaplane
et al., 2005, 2010), Imdorf et a/. (1987) and Imdorf and Gerig (2001)
from Europe, and Gris (2002) and Guzman-Novoa et a/. (2011) from
Central America.

1. Visual estimates of bees on combs will vary according to time
of day and bee foraging activity. For this reason it is important
to control for this effect — either by limiting observations to a
narrow time window on successive days, randomly assigning
time of inspection such that day effect is equitably and
randomly distributed across treatments, or closing hive
entrances in the early morning until bees are counted.

2. Estimates should be carried out by no fewer than two human
observers, preferably each with a dedicated secretary who
writes down numbers, or each fitted with an audio recorder.

3. A colony is opened and combs of bees sequentially removed.
Each observer looks at one side of a comb, visually estimates
the percentage of the comb surface covered by bees, and
records the number with the secretary or audio recorder. It is
convenient to label frames 1-X, with each side indicated A or
B. For beginners it is advisable to “calibrate the individual”
with estimates made by an experienced observer. Observers
describe the process as a kind of mental “resorting” the bees,
such that the bees are imaginatively moved into a contiguous
mass on the comb surface, at which point the reader
estimates the percentage surface of the comb they cover. It is
important to visually sort the bees into a contiguous mass that
approximates their density if the frame were fully covered
because the bee densities given in Table 2 (1.23 — 1.77 bees
per cm?) apply to combs at full carrying capacity.

4. Investigators can use the values in Table 2 or calculate the

comb side surface area unique to their equipment. Fig. 8 is a



G2 B fx| =(F2*880)
A B e D E F G H
1 |colony frame side observer 1 cbserver2 mean of observers cm2 covered by bees bees per side
2 i 1A 0.2 0.3 0.25| 2201 303.6
3 1 1B 0.3 0.5 0.4 352 485.76
4 1 A 0.4 0.4 0.4 352 485.76
) 1 2B 0.5 0.6 0.55 484 667.92
6 1 3A 0.7 0.8 0.75 660 910.8
g 1 3B 07 07 0.7 616 850.08
8 1 4 A 0.5 0.4 0.45 356 546.48
9 1 4 B 03 03 0.3 264 364.32
10 1 5A 0.4 0.2 0.3 264 364.32
11 1 5B 0.1 0 0.05 44 60.72
12 colony bee population' 5035.76
13 2 1|A o 0 0 0 0
14 2 1B 0.2 0.3 0.25 220 303.6
15 2 1A 0.4 0.4 0.4 352 485.76
16 2 2B 0.5 0.6 0.55 484 667.92
17 2 3A 1 0.9 0.95 836 1153.68
18 2 iB 0.9 0.8 0.85 748 1032.24
19 2 4 A 0.7 0.8 0.75 660 910.8
20 2 4 B 0.5 0.5 0.5 440 607.2
21 2 5A 0.3 0.4 0.35 308 425.04
22 2 5B ] 0 0 0 0
23 colony bee population 5586.24

Fig. 8. Example Excel worksheet for converting raw observer data

into colony bee population. See 4.2., paragraph 4.

screenshot of an Excel datasheet demonstrating the
conversion of raw data from two observers into colony bee
population. There are two fictional colonies, each with 5 North
American deep frames, each with two sides. Columns D and E
show the respective visual estimates of two observers for
percentage comb surface covered by bees, and column F is
the mean of the two. Column G converts the mean
percentage surface covered by bees into area (cm?) covered
by bees, using the surface area for one side of a North
American deep frame from Table 2 (880 cm?). Column H
converts cm? bees to number of bees with the appropriate
bee density (1.38 bees / cm?). Finally, rows 12 and 23 sum
the bees of each frame and side to yield colony bee population.

5. If investigators use colonies with different sized supers and
frames it will be necessary to adjust calculations for the one-
side surface area unique to each comb type. Bee density at
full carrying capacity is consistent within North America or
Europe, so it should be adequate to pick a density value from

Table 2 that best fits one’s local situation.

4.3. Special considerations for measuring adult
bee populations in African bees

When it comes to African bees, the methods described in 4.2. must be
modified to account for the fact that these bees immediately fly when
disturbed.

1. Two observers plus a dedicated data recorder are
recommended as before.

2. The key difference is that each observer makes a visual
estimate of the percentage surface of the comb occupied by
bees immediately as one of them withdraws it from the hive.
Each observer is responsible for only one side of a comb.

3. To minimize loss of bees it is necessary to keep the hive intact

as much as possible, working downward, removing the lid

Delaplane et al.

then first measuring bees in honey supers, then bees in the
brood chambers.

4. Raw data are converted into colony bee population using Table
2 and the methods given in Fig. 8.

5. An alternative to visually estimating bees on combs is to
rapidly remove each frame and immediately shake the bees
into a large plastic bag. The bag is weighed to determine total
net weight (kg) of bees, then a fresh sample of ca. 20 g bees
collected. The bees in the bag are returned to the colony and
the sample taken to the lab where it is weighed, frozen, and
the bees counted to determine g per bee. Dividing total net

weight by g per bee gives colony bee population.

5. Measuring brood, honey, pollen,
and other colony strength parameters
during the experiment

5.1. Subjective mode

This section describes a subjective mode for reporting quantity of any
kind of colony resource stored in cells: open brood, sealed brood,
honey, or pollen. The methods are similar to those described for
measuring colony bee populations subjectively in section 4.2. The only
difference concerns whether the investigator wants to report the
resource in units of area (cm?) or number of cells. Authors have also
reported resources in units of “frames,” but this is unnecessarily
ambiguous and makes it harder to compare data to other studies. As
mentioned before, honey is traditionally reported as weight (kg), and
it is best to use queen excluders and pre-weighed honey supers as
described in paragraph 8, section 4.1. However, if the investigator
wants to report honey occurring in combs alongside brood it may be
necessary to report it in units of cm? or cells as described in this
section. These methods for measuring brood, honey, or pollen are
fundamentally the same for African bees, given that the investigator
uses the region-specific multipliers in Table 2.

1. Estimates are carried out by no fewer than two observers,
preferably each with a dedicated secretary who writes down
numbers, or each fitted with an audio recorder.

2. A colony is opened and combs of bees sequentially removed.
Each observer looks at one side of a comb, visually estimates
the percentage of the comb surface occupied by the target
resource, and records the number with the secretary or audio
recorder. It is convenient to label frames 1-X, with each side
indicated A or B. As described in the previous section, the
observer is imaginatively sorting the resource into one
contiguous mass and making a decision on the percentage
surface area of the comb the contiguous resource occupies.

This can be difficult in cases of spotty brood where widely
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Gl2 fx| =5UM(G2:G11)

A B £ D E F L7
1 |colony frame side observer1 observer2 mean of observers cm2 covered by open brood
2 1 1A 0.1 0.2 0.15 132
3 1 1B 0.3 0.4 0.35 308
4 1 2A 0.6 04 0.5 440
ol 1 26 0.7 0.6 0.65 572
6 1 3A 0.8 0.8 0.8 704
7 i 3B i i i 880
8 i b 4 A 0.5 1 0.95 836
9 b 4B 0.8 1 0.9 752
10 i 5A 0.5 04 0.45 356
L1 1 5B 0.1 ] 0.05 44
zl sum cm2 of colony open brood
13 s 1A ] ] o ]
14 2 1B 0.1 03 0.2 176
15 2 2A 0.5 04 0.45 356
16 2 28 0.5 0.6 0.55 484
17 2 3 A 0.5 0.9 0.9 752
18 2 3B 1 08 0.9 752
19 2 4 A 0.7 07 0.7 616
20 2 4B 0.3 0.4 0.35 308
sl 2 5 A o 01 0.05 44
22 2 5B '] 0 o ']
23 sum cm2 of colony open brood 3608

Fig. 9. Example Excel worksheet for converting raw observer data

into cm? open brood. See 5.1., paragraph 3.

separated cells must be imaginatively grouped together. It is
to be expected that the accuracy of this mode is best when
target resources are massed together in convenient
contiguous patches.

3. Fig. 9 is a screenshot of an Excel datasheet demonstrating the
conversion of raw data from two observers into cm? of target
resource, in this example open cells of brood. There are two
fictional colonies, each with 5 North American deep frames,
each with two sides. Columns D and E show the respective
visual estimates of two observers for percentage comb
surface occupied by brood, and column F is the mean of the
two. Column G converts the mean percentage surface occupied
by open brood into area (cm?), using the surface area for one
side of a North American deep frame from Table 2 (880 cn?).
Rows 12 and 23 sum the area of open brood for each colony.

4. If investigators use colonies with different sized supers and
frames it will be necessary to adjust calculations for the one-
side surface area unique to each comb type. This would affect

the area conversion factor used in Fig. 9, column G.

H2 = Sfx| =(G2*3.7)
A B L9 D E F G H
1 |colony frame side observer 1 observer 2 mean of cbservers cm2 covered by open broed cells open brood
2 1 14 01 0.2 0.15 132 amsa]
3 1 1B 03 0.4 035 308 11356
4 1 A 0.6 0.4 0.5 440 1628
5 1 2B 0.7 0.6 0.65 572 2116.4
6 1 3A 0.8 0.8 0.8 704 2604.8
7 1 3B i i 1 880 3256
8 1 4 A 0.9 1 0.55 836 3093.2
9 1 4B 0.8 i 0.9 792 25830.4
10 1 5A 0.5 0.4 045 396 1465.2
11 1 5B 0.1 0 0.05 44 162.8
12 sum cells of colony open brood r 18884.8
13 2 1A 0 0 o 0 o
14 2 1B 0.1 0.3 0.2 176 651.2
15 2 A 0.5 0.4 045 3596 1465.2
16 2 2B 0.5 0.6 0.55 484 1750.8
17 2 IA 0.9 0.9 0.9 792 2530.4
18 2 3B 1 0.8 0.3 792 2530.4
19 2 4 A 0.7 0.7 0.7 616 2273.2
20 2 4B 03 0.4 035 308 11356
21 2 SA 0 0.1 0.05 44 162.8
22 2 5B 0 0 1] 0 o
23 sum cells of colony epen brood 133456

Fig. 10. Example Excel worksheet for converting raw observer data

into cells open brood. See 5.1., paragraph 5.

5. To report a resource in units of cells, it is necessary to
multiply the cm? of resource by the average cell density per
cm?. This value varies by geography; conversion factors range
from 3.7 - 4.7 (Table 2). It is advisable for investigators to
determine this value for their local conditions. Figure 10
shows a modification of Fig. 9 taking the data from cm?open

brood to cells of open brood, using a conversion factor of 3.7.

5.2. Computer-assisted digital image analysis

Computer-assisted digital image analysis can be used to directly
measure surface area of comb occupied by bees or other colony
resources such as open brood, sealed brood, or pollen. There are two
kinds of data output: 1. direct surface measurements (cm? or dm?) of
target (Cornelissen et al., 2009) (section 5.4.) and; 2. ratio of surface
target relative to total comb surface (Yoshiyama et a/, 2011) (section
5.5.). In the case of 1., it is possible to convert surface to units of

bees or cells using conversion values in Table 2.

5.3. Technology and photographic considerations

1. A high-resolution camera (3648 x 2736, 10 megapixels, or
higher) is preferred. We recommend a DSLR or similar
camera. Compact cameras will work fine too, but it is unlikely
that eggs and young brood will be visible.

2. Use image formats with the least amount of compression
(resulting in the larger file size). For DSLR cameras this will be
either RAW or TIFF format, and for compact cameras JPEG.
As Image J software doesn't support the use of RAW images,
conversion to either TIFF or JPEG files (uncompressed) is
required. This can be done using free-ware such as Irfan-View

(bttp://www.irfanview.com/}.

3. Use of a tripod with a fixed distance to the frames is

recommended. This makes image analysis easier and pictures
more comparable.

4. Make sure the object (comb frame) completely covers the
picture. This will result in the highest resolution and optimal
lighting conditions.

5. Itis advisable to use Shutter speed priority (indicated with an
“S"” on camera) with a setting of 1/125. Lower shutter speeds
can result in blurred bees as their movement is caught on
camera. In low light conditions use a flash or adjust ISO values.

6. Aperture settings are dependent on the type of lens used. For
DSLR we suggest using a fixed 50 mm lens. These generally
are affordable, sharp, fast (low f-value, e.g. f1:1.4), and have
little distortion. Using these lenses the f-value should be
above 4.5 for sharp pictures. For zoom lenses aim at an f-
value of between 6.7 and f13.

7. Cloudy conditions can create low light levels; likewise the sun

can obscure details due to high contrasts. Optimal results are


http://www.irfanview.com/
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possible with a shaded location and a flash, but in our
experience this is not practical due to terrain difficulties and
limited battery life. Cloudy weather is no problem when using
a fast lens. When it is sunny, it is best to take pictures with

one’s back to the sun.

5.4. Direct surface measurements of target

1. Photographic records of bees on combs will vary according to
time of day and bee foraging activity. For this reason, it is
important to control for this effect, either by limiting
observations to a narrow time window on successive days,
randomly assigning time of inspection such that day effect is
equitably and randomly distributed across treatments, or
closing hive entrances in the early morning until bees are
counted. This constraint does not apply to cell-based
resources such as brood, honey, or pollen.

2. Hives are lightly smoked, opened, and frames permanently
labelled: frame 1 side A or B, frame 2 side A or B, and so forth.

3. Each frame is removed and photographed on each side in such
a way that colony and frame labelling are recorded. It is
preferable to use a custom-built holding mount where each
comb is placed in a holder and the distance between the
comb and camera fixed.

4. Combs are first photographed with bees. If additional comb
resources are of interest, then the bees are brushed into a
holding box and the comb photographed again to expose
brood, honey, or pollen. It is important to avoid brushing bees
back into the hive because this will affect the photographic
bee record of subsequent frames. Eggs and 1 — 3 day old
larvae may be hard to see and if these brood stages are the
objective of the study it is preferable to apply digital cell /

location recognition software.

Step |. Open “File” and click “Open.” |‘—
¥
Step 2. Select the pictogram “straight line" and draw a straight line over a known distance, e.g., from inner edge
to opposite inner edge of frame top bar.
¥
Step 3. Open “Analyze” and click on “set scale,” fill in “known distance” and “unit of length.” |
¥
Step 4. Select pictogram “free-hand line” and orbit area of bees or target cells. |
¥
Step 5. Open “Analyze” and click measurement = (Ctrl+M). |
¥
Step 6. Results are given in cm? or dm? depending on scale set in “Result” sheet. |
¥
Step 7. Open next photo via step | (Ctrl+Shift+O) |—
¥

Step 8.After finishing a series, copy results to an Excel file for remaining calculations. |

Fig. 11. Outline of the method of Cornelissen et a/. (2009). Flow
chart of computer assisted image analysis applying Image] software.
Step 2 can be skipped by making the photos in a fixed position at

which the distance between camera and frame is constant.
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Table 3. Colour- and number-coding of cell contents according to
OECD (2007).

Brood stages / stores Colour Number
empty cells Brown 0
eggs Blue 1
young larvae (1-3 days) Green 2
older larvae (4-6 days) Red 3
pupae (capped brood) Yellow 4
nectar orange 5
pollen / bee bread deep pink 6
dead larvae / pupae dark salmon 7
not characterized (nc) White 8

5. The digital photos are analysed using a computer program

such as Imagel, available free at http://rsbweb.nih.gov/ii/]

Post-hoc, the photos are uploaded in the computer and
analysed as diagrammed in Fig. 11.

6. The results of the calculated area is in dm? or cm? depending
on the scale that has been set. To finish the analysis, the
number of bees or cells are derived with Excel or a similar
spreadsheet program using the expected density of bees per
cm? or cells per cm? given in Table 2. Surface data from this

digital analysis could be inserted into Column G in Figs 8-10.

5.5. Ratio of target surface relative to total comb
surface area

This method, also applying Image], yields the ratio between selected
area and the total comb area. Prior to computer analysis, each digital
image of a comb side is digitally edited by the investigator to
delineate comb areas of target resource, e.g. capped brood area,
open brood, pollen, or honey with unique identifying colours. In Fig. 12,

this application is outlined.

Step |. Download http://Ibm.ab.a.u-tokyo.ac.jp/~i ae/ and save in a dedicated file. |

¥

Step 2. Open Image]. Open Plugins > New > Plugin > File > Open: [filename stored in Step 1] > Save. LarvaeArea is now
in Plugins in Image).

Step 3. Download a target photograph. |

¥

Step 4. Using photo editing software, encircle and colorize areas of interest (open brood, closed brood, etc.) according to
Table 3. Save colorized photo.

Step 5. Open the colorized photo in Image]. |

-«

Step 6.Total comb area is set by orbiting the total comb surface with the polygon lasso tool (pictogram polygon). |

-«

Step 7. Select Pictogram > Color picker > and select color of target of interest. |

-«

Step 8. Click Plugins > LarvacArea. |

¥

Step 9.The result is given as ratio of target area : total comb area. |

Fig. 12. Outline of method of Yoshiyama et a/. (2011) for determining
ratio of target surface : total comb surface. It is used with the OECD

colour codes in Table 3.


http://rsbweb.nih.gov/ij/
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5.6. Flight activity

1.

Bee flight activity can be monitored visually at hive entrances
to gain a relative measure of colony foraging effort. To control
for between-colony variation due to time of day, the investigator
should: 1. limit observations to days and time of day with good
flight conditions; 2. randomize the numeric order in which
colonies are measured; 3. measure all colonies within a relatively
narrow window of hours, and; 4. limit colony observations to the
same time window over successive days.

Two observers sit to the side of a colony, each positioned well
enough to the side to avoid obstructing the flight of the bees.
Each observer has a hand-held counting device and one keeps
time.

For one 15 min counting episode, each observer counts and
records the number of bees exiting the colony (but see
below). Exiting bees are simpler to count because returning
foragers land with less predictability; some directly into the
entrance, others onto the front of the hive.

The mean of the two observers is derived and the data
reported as exiting foragers per min.

Investigators may want to focus on returning, instead of
exiting foragers, especially if pollen foraging is a parameter of
interest. In these cases observers need to count foragers
returning with, and without, corbicular pollen loads in order to

derive proportion of foragers collecting pollen.

5.7. Comb construction

This section draws upon methods of Matilla and Seeley (2007).

1.

This metric can be collected only during times of rich nectar
flow when bees can draw out new comb.

Colonies are each provided a hive body provisioned with ten
new frames; 5 combless and 5 with wax foundation,
alternating. The use of alternating frames of foundation
encourages bees to build combs in compliance with the
removable-frame parallel orientation of Langstroth equipment.
Measures of area of comb constructed (both natural and on
the foundation) by each colony can begin two days after
establishment and weekly thereafter until all comb is finished
or the nectar season is over. Comb area on both sides of
every frame is determined and summed by colony, either with
the Objective mode (4.1.) or Subjective mode (5.1.).
Inexperienced observers will need to be trained to
discriminate differences between natural comb and the

imprinted beeswax foundation.
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5.8. Queen cell production

This measure can be determined while the colony is being opened
and measured for other strength metrics. It should be done after bee
population measures have been taken. Every brood comb is shaken
free of bees and examined carefully for the presence of queen cells
provisioned with royal jelly and a larva. The cells are counted and
then cut out for two reasons: 1. to prevent swarming (unless
swarming is a variable of interest) and; 2. to prevent redundant
duplicate observations on subsequent samples. For each block of the
experiment this variable can be reported as sum of queen cells
constructed per colony.

5.9. Drone brood production

This measure is best taken in spring or early summer when drones
are being actively reared. It is nothing more than an extension of the
Objective mode (4.1.) or Subjective mode (5.1.) limiting observations
to drone cells filled with larvae or capped with pupae. Values for
drone cells per cm?for European bees range from 2.3 (J A Berry,
University of Georgia, USA, pers. obs.) and 2.6 (Dadant, 1963); a
good estimate for African races is 3.0 (Buco et al, 1987; Hepburn,
1983).
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